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Copyright and Terms of Use 
Please leave all references to FridgeMonsters intact in the documentation and 
code examples.  
 
1. Except as otherwise provided, the contents of these notes shall not be 
reproduced, republished, uploaded, posted, transmitted or distributed 
electronically or non-electronically in any way, without FridgeMonsters prior 
written permission. 
 
2. Modification of any of the contents or use of the contents for any other purpose 
will be a violation of FridgeMonsters copyright and other intellectual property 
rights. Graphics and images in these notes are protected by copyright and may 
not be reproduced or appropriated in any manner without written permission of 
FridgeMonsters. 
 
3. FridgeMonsters reserves all rights to deny or restrict access to these notes to 
any particular person or persons, or to block access from a particular Internet 
address to the FridgeMonsters.com Web Site, at any time, without ascribing any 
reasons whatsoever. 
 
4. These Terms of Use shall be governed and construed in accordance with laws 
of the Republic of Singapore. 
 
For full details, please view the Terms of Use document at :  
 
http://www.FridgeMonsters.com/administration/terms.asp 
 
5. Please report any errors in this tutorial to errata@FridgeMonsters.com 
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Introduction 
In this tutorial cover introduction to creating 3d Text in MAYA. This tutorial 
specifically looks at the options available for bevelling and optimising models.  
 
Learning Outcome 
The objective of this tutorial is to introduce you to the following :  
 

1. Creating 3d Text. 
2. Bevel Plus (Surfaces). 
3. Creating Polygon Text. 
4. Reduce (Polygon) Tool. 
5. Optimised Text. 
6. The various Bevel options available. 
7. Separating Objects 
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Setting the Project 
The Project folder contains all the sub-folders for your project. It allows your 
scene to source for all the appropriate files and references in an organised 
manner. 
 
New Project 
File > Project > New 

1. Name the Project 
2. Location to Save the Project 
3. Set Folder Names 

 
Name the Project : lower case character, obvious names with no spaces 
Location of Project : The default location is set to Documents Folder, but if you 
are not working on your own computer it’s better to save it to the Desktop. Copy 
this Project folder to your portable device when you have finished this tutorial. 
 
Do not save your project to a portable drive (thumb drive) or the performance 
will lag. 
 
 

 
 
Name your project : text101. Click the Use Defaults button to set the Project 
Data Locations. Then click Accept. 
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Installing Fonts 
The font used in the tutorial is Hasty Pudding (by UddiUddi), available from 

www.dafont.com/hasty-pudding.font. To get the most out of this tutorial it is 
recommended to use the same font. However, you are free to download and use 
any font you wish in future. 
 
To install the fonts, first ensure that they are compatible with your system 
(Windows or MAC OS). Download the file and uncompress it. Then copy the font 
files (HASTP___.TTF) into the system font folder.  
 

Windows : C:\Windows\Fonts 
MAC OS : path here 
 

It is then advisable to Restart your computer to ensure the fonts are successfully 
loaded into the system font manager (automatically done when the system starts 
up). If the font is not loaded into the font manager you will not be able to use it.  
 
Note : Hasty Pudding font is also available at www.FridgeMonsters.com/

@
 

modelling/text101  
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Getting Started 
An important aspect of this tutorial is optimising the text by reducing the number 
of faces used to create the geometry. Start this tutorial by creating a new scene 
and displaying the scene statics in the viewport – the number of vertices and 
faces. 
 

Display > Heads Up Display > Poly Count 
 
 
 

 
 

As you reduce the faces in the geometry, it will be useful to see how it affects the 
shading and the integrity of geometry. Set the viewport shading to Smooth 
Shade All and to display Wireframe on Shaded. 

 
 

 
 
 
OK, we’re now ready to start creating the text. Open the Text editor, located 
under the Create menu. 
 

Create > Text > Options 
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The first thing you need to do is enter the string of text you’d like to create. Enter 
the text “FridgeMonsters” in the text field. Then select the font (text style) by 
clicking on the down arrow at the end of the Font field.  

 

 
The down arrow opens the Font window, allowing you to browse and select the 
fonts installed on your computer. You also have the option of setting the Font, 
Style and Size.  
 
The Size option is convenient for initially displaying the text in the viewport, but 
once you have created the text geometry, you have the option of scaling it to any 
size you want. Set the font Size to 48, so the text is clearly displayed in viewport.   
 
Note : The options available under Effects (Strikeout, Underline and Color) are 
redundant and have no affect on the text at all. 
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Click OK. 
 
 
Bevelling Geometry 
MAYA (and all other 3d software) creates geometry as simply as possible, with 
sharp corners and edges. This is efficient and acceptable for small incidental 
models or objects in the background. But, if the objects are larger and in the 
foreground of the scene, it’s aesthetically better to remove these sharp edges by 
bevelling them. This simply allows you to round the edges off, with a variety of 
settings. The effect of this is the light will pick out a specular high-light along the 
edges of the objects. It makes the object look less computer generated. 
 
 

 
(left to right) no bevel, small bevel, large bevel, large smooth bevel 

 
Set the Type to Bevel and notice an extensive list of options with values and 
parameters become available.  
 
These options are concerned with how the edges of the text geometry are 
bevelled and will be covered in-depth later in this tutorial. For now, we just want 
to see the result of the default settings. 
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Set the options and values as indicated in the diagram below. 
 

 
 
Before clicking OK, just take a look at the Text Curves Options above.  
 
Notice that the Text is set to “FridgeMonsters”. The Font is set to Hasty 
Pudding. The text is bevelled at the Start (front) and End (back). The width 

and depth of the bevel is set to 0.3 units. The distance the text is Extruded is 
2.0 units. Finally, the Outer Bevel (around the outside edge) and Inner Bevel 
(around the edge of holes eg. “O”, “p” and “B”) are both set to Convex Out.  
 
See the diagram below. 
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Click OK. The text is created. Ideally this should be the end of the tutorial. 
However, there is a very serious problem. Take a look in the viewport at the 
number of faces used to create this simple string of text, comprising of just 14 
characters.  
 

…20,310 faces…!! 
 

 
 
This is rather excessive. If it is our intention to use this text as a small shop sign 
in the background of the scene, which is barely noticed in a heavily modelled 
urban environment, this would be an inappropriate use of detail. It would be 
considered over detailed. Remember, the larger the face count (number of faces) 
in your scene, the longer it takes to load and render. It also causes your 
interaction with the scene to lag (delay updating). For this reason, you need to be 
efficient and apply modelling detail in the scene where it is needed (objects in the 
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foreground) and be more sparing with the number of faces for incidental assets 
(models). 
 
So, even though you have successfully created the 3d text, you need to get the 
same results with considerably less faces.  
 
Create a new scene (do not save the old one). Open the Text editor, located 
under the Create menu. 
 

Create > Text > Options 
 
 

 
 
 

Set options and values as indicated below, but this time set the Type to Curves. 
 

 

 
 
 
 

Click OK. 
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Notice in the viewport this has created a series of NURBS Curves for the letters. 
The letters are not objects and therefore do not have faces and can not be 
rendered.  
 

 
 
 

The next step is to select each of the Curves in the viewport and then extrude 
and bevel them using the Bevel Plus tool. 
 

Surfaces > Surfaces > Bevel Plus 
 
 

 
 
 
Set options and values as indicated below, and then click the Output Options 
tab. 
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Note : Take note that the options and values used for the Bevel tab are the 
same as previously used with the Text tool. 
 
Under the Output Options, set the options and values as indicated below.  
 

 
 

Along Extrusion : Section 
Evenly space the divisions along the Extruded text.  

Samples : 2 
The number of subdivisions in the resulting tessellation. 

Along Curve : Span 
With Span turned on, the subdivision occurs between each span of 
the source curve. Each span will have the same number of 
subdivisions, as specified in the Samples setting.  

Samples : 6 
 
 
Note : When Bevelling text with holes, such as d,g,o,e,A,P,B,D, select the outline 
of the letter first and then ([shift] + select) the holes. Then Bevel.  
 
Note : Save time by simply selecting the curve and pressing [g] on the keyboard 
to repeat the last Command – Bevel Plus.  
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When you have finished your 3d text should look like the diagram above. The 3d 
looks the same as previously created using the text tool. However, take a look at 
the face count. It has dropped from 20,310 faces to 5,100. Excellent..!! 
 
But, we are not finished there. As this text is a static asset (a model that does not 
move or bend) it is possible to optimise the model and reduce the face count 
even further. 
 
Separating the Letters 
Currently, the text is created as one piece of geometry and therefore the letters 
can not be individually translated, rotated, scale or animated. If you need to 
separate the letters, select the text and use the separate function. 

 
Polygons > Mesh > Separate 
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Open the Reduce tool. 
 

Polygons > Mesh > Reduce 
 

 
 

 
Select the Letter “F” and notice that number of faces for this object is currently 

392.  
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Set the Reduce by (%) value to 20.  
 

 
 

Click Reduce. 
 
 
Letter “F” now has a face count of 313, reduced from 392.  
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Repeat the Reduce step for all 14 letters (don’t forget the dot above the “i”). 
Once you have completed that, the face count now stands at 4084..  …A huge 
reduction from 20,310 faces. 
 

 
 
In this example the text is intended for use as a shop sign against a wall. As the 
camera never goes behind the text, the bevel at the back (At end) of the text is 
redundant and can been removed. 
 
Create a new scene (do not save the old one). Open the Text editor, located 
under the Create menu. 
 

Create > Text > Options 
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Note : Take note that the options and values used for the Bevel tab are the 
same as previously used with the Text tool and Bevel. 

 
 

Click the Output Options tab and set the options and values as indicated below.  
 

 
 

In this final exercise we have modified the Output Options to reduce the 
number of sections created in the extrusion and around the edges of the text.  
 

Along Extrusion : Complete 
The subdivisions along the extruded text occur along the entire 
bevelled surface, from one surface cap to the other.  

Samples : 1 
The number of subdivisions in the resulting tessellation. 

Along Curve : Span 
With Span turned on, the subdivision occurs between each span of 
the source curve. Each span will have the same number of 
subdivisions, as specified in the Samples setting.  

Samples : 2 
The number of subdivisions in the resulting tessellation. 
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Bevel Plus all 14 letters (don’t forget the dot above the “i”) and reduce the face 

count with the Reduce tool. 
 

Polygons > Mesh > Reduce 
 

Once you have completed that, the face count now stands at 1,382..!!  …A huge 
reduction from the previous Bevel Plus settings of 4,084 faces and the 20,310 
faces for the Text tool. 
 
 

20,310 faces to 1,382 faces  
 
 
Note : This is a much more realistic value for the face count. It just goes to show 
that learning how to optimise your assets (models) has an enormous impact on 
the efficiency of your scene and most importantly, the rendering times.  

 

 
 
On a final note, it is worth pointing out that even after you have created the text, 
the Bevel values can be modified in Channel Box. 
 

 
 
Note : Don’t forget to delete the History and Freeze Transformation when you’ve 
finished modelling your text.  
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Glossary of Bevel Styles 
The examples below are bevelled with the following values.  
 

Width : 0.3 
Depth : 0.3 
Extrude Distance : 2.0 
 

Each example contains a Perspective view and Top view of the text. 
 
 
Straight Out 

 
 
 
Straight In 

 
 
 
Concave Out 
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Concave In 

 
 
 
Convex Out 

 
 
 
Concave In 
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Straight Corner 

 
 
 
Convex Front Edge 

 
 
 
Convex Crease 

 
 
 
 
 
 


